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What is the ETD Manual? 

The Graduate and Professional School has created the Electronic Thesis and Dissertation 
(ETD) Manual to assist graduate students with formatting and submitting their thesis/
dissertation. The ETD Manual includes information on submission timetables, formatting 
(either with the pre-formatted templates and non-template users), digital accessibility 
compliance, copyright, Vireo, etc.  

Order of Events: From Writing to Submitting your 
Thesis/Dissertation 

Below is a detailed timetable of tasks that need to be completed to graduate. These 
requirements must be completed the semester you intend to graduate.  

1. Initiation Sheet: The initiation sheet should be submitted once the graduate 
student completes coursework, registered for thesis/dissertation writing courses 
(ABD/ABT) and formed their thesis/dissertation committee. Email form
to thegraduateschool@shsu.edu. Note: If a member is not employed by SHSU, a 
Non-SHSU Employee Committee Request Form must be submitted to the 
Graduate School for the individual to serve on a thesis/dissertation committee. 
Make sure all applicable signatures are on the request form and attach the non-
SHSU member’s Vita to the email along with the request form. Also, SHSU 
committee members must maintain their Graduate Faculty Membership status to 
remain on a committee. Faculty and students can check committee member status 
under the Faculty and Staff Resources tab on The Graduate School webpage.

2. First Draft Review: Thesis/Dissertation 1st drafts should be submitted to the 
Thesis/Dissertation Specialist at tgsthesis@shsu.edu by the set deadline. Graduate 
students must submit all required sections (i.e., title page, approval page, table of 
contents, vita, etc.) plus THREE CHAPTERS of their thesis/dissertation. Include 
your name, SAM ID, and chosen style guide (i.e., MLA, APA, Chicago, etc.) 
when submitting your draft.  After the document is reviewed, you will be emailed 
a draft review checklist that will provide all corrections that need to be made. 
Note: It is the graduate student’s responsibility to ensure their
thesis/dissertation meets all SHSU regulations and guidelines. The ETD Manual 
and Draft Review Checklist has instructions on formatting thesis/dissertation 
documents following SHSU guidelines. If you need to delay your graduation, you 
must resubmit your 1st draft for the semester you intend on graduating.

3. Public Defense Announcement: A public defense announcement should be 
completed two weeks prior to the defense. Email form
to thegraduateschool@shsu.edu. If applicable, please attach your
college/department (internal) defense announcement for verification purposes. An 
example of the public defense announcement has been provided to assist with 
proper formatting. Public Defense Announcement Example.

mailto:thegraduateschool@shsu.edu?subject=Initiation%20Sheet
https://www.shsu.edu/dept/graduate-studies/faculty-staff-resources.html
mailto:tgsthesis@shsu.edu
mailto:thegraduateschool@shsu.edu?subject=Public%20Defense%20Announcement
https://www.shsu.edu/dept/graduate-studies/forms/PDA%20TEMPLATE%20EXAMPLE%202.pdf
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4. Public Defense: A public defense of your thesis/dissertation should be completed 
by the deadline stated in the academic calendar. Students can also find this 
deadline below. Coordinate with your Chair, committee members and department 
on scheduling your defense.

5. Route Sheet: Graduate students should submit a route sheet immediately after 
successfully defending their thesis/dissertation. Read the instructions carefully 
and fill out the form correctly. This information will be sent to the Registrar’s 
Office for degree program and graduation purposes.

6. Embargo Request: Graduate students who are seeking a one-year, two-year or 
permanent embargo must submit an Embargo Request Form by the deadline. 
Students must be approved for an embargo by the Dean of The Graduate School. 
Email form to thegraduateschool@shsu.edu. Note to Faculty and Graduate 
Students: Faculty can submit an embargo request form on behalf of a student by 
filling out the applicable fields on the form. Please be aware that failure to submit 
an embargo request by the deadline is ultimately the graduate student’s 
responsibility. An Embargo allows a thesis/dissertation to be withheld from being 
published digitally via SHSU’s institutional repository either temporarily or 
permanently providing students an opportunity to have their research published in 
an academic journal, as a novel or to acquire a patent. Students must submit all 
requirements listed in this section regardless of an embargo approval.

7. Final Draft Review: The final draft review should be submitted to the
Thesis/Dissertation Specialist at tgsthesis@shsu.edu after revising all format 
issues included in the 1st review checklist as well as all approved edits by 
committee members. The document should be completed in its entirety and 
submitted to the Thesis/Dissertation Specialist at tgsthesis@shsu.edu after 
revising all format issues included in the draft review checklist as well as all 
approved edits by committee members. Final drafts should be submitted after 
successfully defending your thesis/dissertation. Make all necessary changes to 
your document before submitting for final review. THIS IS THE FINAL 
SUBMISSION OF YOUR DOCUMENT. THROUGHLY PROOFREAD YOUR 
FINAL DRAFT FOR GRAMMER AND FORMATTING ISSUES.

8. Vireo and Embargo Submission: The Thesis/Dissertation Specialist will email a 
final pdf version of your approved thesis/dissertation document to submit through 
Vireo (No additional edits can be made to your approved document). Follow the 
instructions, fill in all sections correctly and upload the approved pdf file. If a 
graduate student was granted a one-year or two-year embargo, fill in all sections 
that apply. Graduate students who have been approved for a permanent embargo 
do not submit their final document through Vireo; students should follow the 
Permanent Embargo Instructions to submit their document to the Newton 
Gresham Library. Note: It is important that embargo requests and Vireo 
submissions be completed in a timely manner. Failure to do so will delay final 
route sheet approvals which need to be confirmed by the Registrar for 
commencement purposes.

mailto:thegraduateschool@shsu.edu?subject=Embargo%20Request
mailto:tgsthesis@shsu.edu?subject=2nd/Final%20Draft%20Review
mailto:tgsthesis@shsu.edu?subject=2nd/Final%20Draft%20Review
https://shsu-etd.tdl.org/
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Thesis/Dissertation Public Defenses Via Zoom 

***ATTENTION: If you're planning to defend your thesis/dissertation via Zoom, 
please follow the tips below to safeguard against Zoom-bombing: 

• Do not use your Personal Meeting ID. Set-up an ID that will generate
automatically when creating the meeting.

• Require a meeting password. Do not overshare your password. Only give it to
those who will be attending the meeting.

• When creating the meeting, check the 'Enable Waiting Room' and 'Mute
Participants on Entry' in the Advanced Options section.

• To prevent harassment of other participants, inappropriate images, and GIFs in
the chat, disable file transfer and private chat. Go to settings in the Zoom web
app. Select Personal, then Settings and click In Meeting. Go to File Transfer and
Private Chat to disable (Note: The gray button indicates when the Private Chat is
disabled).

• Once the meeting has started, select the arrow next to the green Share Screen
button, then Advanced Sharing Options and select 'One participant can share at a
time' and 'Only Host' in the designated sections. Assign your Chair and one other
committee member as co-hosts. If you experience a Zoom bomb during your
defense, go to Participants List, scroll down to More and click Lock Meeting.
Have one of your co-hosts go to Participants List, scroll to the bottom, and click
Mute All Controls to cut the hacker’s microphone/audio.

Approved List of Style Manuals/Guides 

The following style manuals have been accepted by the Sam Houston State University 
Graduate Council. Students must use one of the style guides listed below. The exception 
to this requirement is students whose document qualifies as a journal-model 
thesis/dissertation. The most recent edition of these manuals should always be 
followed.  CONSULT YOUR THESIS/DISSERTATION DIRECTOR TO DETERMINE 
WHICH MANUAL IS REQUIRED BY YOUR DEPARTMENT. 

1. ASC Guide to Scholarly Communication (Online)–
https://pubs.acs.org/doi/book/10.1021/acsguide

2. The AP Stylebook, 55th Edition (Online and Book)
– https://www.apstylebook.com/

3. Chicago Manual of Style, 17th Edition or A Manual for Writers of Research
Papers, Theses, and Dissertations, 9th Edition (Online and Book) –
https://www.chicagomanualofstyle.org/home.html

4. AMS Style Guide (Online) – https://www.ams.org/publications/authors/AMS-
StyleGuide-online.pdf

5. MLA Handbook, 9th Edition (Online and Book)– https://style.mla.org/

https://pubs.acs.org/doi/book/10.1021/acsguide
https://www.apstylebook.com/
https://www.chicagomanualofstyle.org/home.html
https://www.ams.org/publications/authors/AMS-StyleGuide-online.pdf
https://www.ams.org/publications/authors/AMS-StyleGuide-online.pdf
https://style.mla.org/
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6. Publication Manual of the American Psychological Association, 7th Edition or
Concise guide to APA Style, 7th Edition (Online and Book)
– https://apastyle.apa.org/

7. Scientific Style and Format: The CSE Manual for Authors, Editors, and
Publishers, 8th Edition (Online and Book)
– https://www.scientificstyleandformat.org/Welcome.html#pt3

8. Style Manual for Political Science, 2018 Edition (APSA) (Online and
Book)– https://connect.apsanet.org/stylemanual/

9. Style Manual: An Official Guide to the Form and Style of Federal Government
Printing, 2016 (GPO) (Online and Book)
– https://www.govinfo.gov/content/pkg/GPO-STYLEMANUAL-2016/pdf/GPO-
STYLEMANUAL-2016.pdf

10. Suggestions to Authors of the Reports of the USGS, 7th Edition (Online)
– https://pubs.usgs.gov/unnumbered/7000088/

11. The Bluebook, A Uniform System of Citation, 21st Edition (Online and Book)
– https://www.legalbluebook.com/

12. AIP Style Manual, 4th Edition (Online)
– https://publishing.aip.org/resources/researchers/ or https://publishing.aip.org/wp
-content/uploads/2021/03/AIP_Style_4thed.pdf

13. ASHS Publications Style Manual (Online Only)
– https://journals.ashs.org/page/publish or https://journals.ashs.org/fileasset/style_ 
manual_1218.pdf

14. Journal of Animal Science (Online Only)
– https://academic.oup.com/jas/pages/General_Instructions

15. AMA Manual of Style, 11th Edition (Online and Book) –
https://www.amamanualofstyle.com

16. ASA Style Guide, 7th Edition (Online and Book) – https://www.asanet.org/
publications/journals/asa-style-guide/?hilite=asa+style+guide

17. IEEE Editorial Style Manual, 2018 — https://ieeeauthorcenter.ieee.org/wp-
content/uploads/IEEE-Editorial-Style-Manual.pdf or https://www.ieee.org/

https://apastyle.apa.org/
https://www.scientificstyleandformat.org/Welcome.html#pt3
https://connect.apsanet.org/stylemanual/
https://www.govinfo.gov/content/pkg/GPO-STYLEMANUAL-2016/pdf/GPO-STYLEMANUAL-2016.pdf
https://www.govinfo.gov/content/pkg/GPO-STYLEMANUAL-2016/pdf/GPO-STYLEMANUAL-2016.pdf
https://pubs.usgs.gov/unnumbered/7000088/
https://www.legalbluebook.com/
https://publishing.aip.org/resources/researchers/
https://publishing.aip.org/wp-content/uploads/2021/03/AIP_Style_4thed.pdf
https://publishing.aip.org/wp-content/uploads/2021/03/AIP_Style_4thed.pdf
https://journals.ashs.org/page/publish
https://journals.ashs.org/fileasset/style_manual_1218.pdf
https://journals.ashs.org/fileasset/style_manual_1218.pdf
https://academic.oup.com/jas/pages/General_Instructions
https://www.amamanualofstyle.com/
https://www.asanet.org/asa-style-guide-sixth-edition
https://www.asanet.org/asa-style-guide-sixth-edition
https://ieeeauthorcenter.ieee.org/wp-content/uploads/IEEE-Editorial-Style-Manual.pdf
https://www.ieee.org/
https://www.asanet.org/publications/journals/asa-style-guide/?hilite=asa+style+guide
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CHAPTER II 

FORMATTING
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Templates 

Students are advised to use the templates to assist with formatting. These templates are 
pre-formatted word documents that have all major sections and page numbers set to 
SHSU standards. There are three templates available: 

1. Traditional Thesis/Dissertation Template: This dissertation is pre-formatted for a 
traditional thesis or dissertation.

2. Journal-Model Template: This is a modified template that includes designation pages 
for journal articles. The template is meant for students who have published or are in 
the process of publishing portions of their thesis or dissertation to academic journals. 
The template is formatted to APA 7. 
A. Doctoral Dissertation Requirement: Students must have A MINIMUM OF     
THREE journal articles that are either already published or intended to be published in 
an academic journal(s).
B. Master’s Thesis Requirement: Students must have A MINIMUM OF TWO journal 
articles that are either already published or intended to be published in an academic 
journal(s). 

3. Creative Thesis Template: The Creative Thesis Templates are non-tradition templates 
for creative works. Version 1 is without chapters and Version 2 has chapters. Students 
can choose which version best suits their thesis or dissertation.

Thesis/Dissertation Arrangement 

Each document is broken down into 13 parts.  The table below provides a list of these sections. 

**NOTE: Sections marked with an asterisk (*) are optional and may be deleted from the 
document.  All others are required according to official SHSU standards. If you are using a 
template, it is recommended to wait until your thesis/dissertation is complete to delete 
optional sections. 

1. Title Page
2. Approval Page
3. Dedication *
4. Abstract
5. Acknowledgements *
6. Preface *
7. Table of Contents
8. List of Tables (If applicable)
9. List of Figures (If applicable)
10. Body of Thesis/Dissertation
11. References, Bibliography or Works Cited
12. Appendix (If applicable. Include any copyright information in the appendix)
13. Vita
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Margins, Spacing, Font and Pagination 

Margins 

• Top: 1”
• Left: 1.5”
• Top: 1”
• Bottom: 1”

Spacing 

Your document should be double-spaced throughout. There are a few exceptions to this 
rule that will be noted as you add content to your document. NOTE: The template will 
show where single-spacing is allowed.  

Font Size and Style 

12 pt. font is required throughout. The only exception to this requirement is tables/figures 
and footnotes which can be reduced to 9-10 pt. font; font must always be legible.  

Acceptable font styles include: 

• Times New Roman
• Helvetica
• Courier
• Geneva
• CG Times

**NOTE: The same font style must be used throughout the entire document. 

Pagination 

• The Title and Approval Page should not have page numbers
• From Dedication to List of Figures, use roman numerals page numbers, bottom

and centered, starting at (iii).
• From the body to the end of the thesis/dissertation, use Arabic page numbers, top

right corner starting at (1).
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Title Page 
 
Checklist for Title Page  
 
Title of document is the same as what appears on the Abstract page and Approval page. 
 

• The title of document uses ALL CAPS. 
• Author's name is the same as what appears on Abstract page and Approval page. 
• The date listed reflects the current semester of publication. Students graduating in 

a later semester must put the current semester of publication on their documents. 
• The correct Department name appears on the Title page. 

Non-template users need to format the approval page as follows: 

1. NO PAGE NUMBER. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch.  
3. Font:  12 pt.  Double-spaced throughout.  Use same font style throughout 

document.  (Use RegText) 
4. Title:  ALL CAPS and centered on first line beneath top margin.  The title may 

take multiple lines depending on its length. 
5. (centered) 1-inch underscore line two spaces beneath the title. 
6. (centered) A Thesis/Dissertation 
7. (centered) Presented to 
8. (centered) The Faculty of the Department <Insert Department Name> 
9. (centered) Sam Houston State University 
10. (centered) 1-inch underscore line two spaces beneath SHSU. 
11. (centered) In Partial Fulfillment 
12. (centered) of the Requirements for the Degree of 
13. (centered) Doctor of <Insert Degree> OR Master of <Insert Degree> 
14. (centered) 1-inch underscore line two spaces beneath degree. 
15. (centered) by 
16. (centered)  <Your official name as found in the Registrar's Office> 
17. (centered) Month of current graduation semester, Year of current graduating 

semester.  [i.e.  May, 2016] 
18. When finished, click on the Insert tab, and click on Page Break to start a new 

section. 
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Approval Page 
 
The approval page is the second page in your document, and it also follows an official 
standard. Physical signatures are no longer required on the approval page.  The Electronic 
Route Sheet has replaced this process, saving you time and hassle.  
 
Checklist for Approval Page 
 
Title of document is the same as what appears on Abstract page and Title page. 

• The title of document uses ALL CAPS. 
• Author's name is the same as what appears on Abstract page and Approval page. 
• All committee member names on the Approval page are spelled correctly and 

have appropriate credentials next to each person’s name. 

Non-template users need to format the approval page as follows: 

1. NO PAGE NUMBER. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch.  
3. Font:  12 pt.  Double-spaced throughout.  Use same font style throughout 

document.  (Use RegText) 
4. Title:  ALL CAPS and centered on first line beneath top margin.  The title may 

take multiple lines depending on its length. 
5. (centered) by 
6. (centered) <Your official name as found in the Registrar's Office> 
7. (centered) 1-inch underscore line two spaces beneath degree. 
8. Tab over to center of page (about 6 times), and type APPROVED: 
9. Tab over to center of page (about 6 times):  Advisor's first and last name, 

followed by credentials. 
10. Tab over to center of page (about 6 times):  Thesis Director 
11. Tab over to center of page (about 6 times):  Committee member's first and last 

name, followed by credentials. 
12. Tab over to center of page (about 6 times):  Committee Member 
13. Repeat steps 10 & 11 until all committee members are accounted for. 
14. Tab over to center of page (about 6 times):  Dean of college's first and last name, 

followed by credentials. 
15. Tab over to center of page (about 6 times):  Dean, College of <Insert name of 

college> 
16. Hit the ENTER button once. 
17. Click on the LAYOUT tab. 
18. Click on the Breaks feature in the Page Setup section. 
19. Select Continuous break.  (This is an important step for formatting page 

numbers.) 
20. When finished, click on the Insert tab, and click on Page Break to start a new 

section. 
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Dedication Page 
 
The Dedication page is optional and can be deleted if you decide not to use it.  
 
Non-template users need to format the approval page as follows: 
 

1. Lower case Roman Numeral (iii), centered, bottom of page.  
2. Margins:  Left margin, 1.5 inch.  Top, Right, Bottom, 1 inch.  
3. Font:  12 pt.  Double-spaced throughout.  Use same font style throughout 

document. 
4. Title: DEDICATION – ALL CAPS, bold, centered on the first line. (Use 

CHPT_Title) 

 
Abstract 
 

All theses and dissertations must have an abstract at the beginning of the document that is 
formatted according to SHSU guidelines.  The abstract is a descriptive summary, no 
longer than 350 words, composed of three principal parts:  

• Statement of the purpose 
• Methods 
• Findings of the thesis/dissertation research 

**NOTE FOR JOURNAL-MODEL THESES/DISSERTATIONS:  Don't confuse this 
abstract with the other abstracts that you will create for each section of a journal-model 
thesis/dissertation.  This main abstract ties together the entire document, summarizing all 
the research and preparing readers on what to expect in your manuscript.  Unavoidably, 
this will duplicate some of the introductory material in each article.  
 
Checklist for Abstract 

• Title of document is the same as what appears on Title page and Approval page. 
• The title of document uses sentence-style capitalization. 
• Author's name is the same as what appears on Title page and Approval page. 
• The date listed reflects the current semester of publication.  Students graduating in 

a later semester must put the current semester of publication on their documents. 
• The correct Major is listed in the Abstract. 
• Key Words are listed at the end of the Abstract.  The first word of each term is 

capitalized.  (Assessment risk, Chemical reaction, Handbook, Optical illusion) 

Non-template users need to format the approval page as follows: 

1. Lower case Roman numeral (iii), centered, bottom of page.  
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
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3. Font:  12 pt.  Use same font style throughout document. 
4. Title:  ABSTRACT -- ALL CAPS, bold, centered on first line.  (Use CHPT_HD 

font style). 
 

Citation. The next line beneath the page's title consists of a single-spaced citation 
of your manuscript.  All theses and dissertations follow the same citation style for the 
abstract:  

Student, Isaac M., The title of the thesis goes here (use sentence-case 
capitalization).  Master of [Fine] Arts/Science or Doctor of Philosophy/Education 
(<Your Major>), May, 2015, Sam Houston State University, Huntsville, Texas. 

The font should be 12 pt. and single-spaced for the citation, and it should be flush-left on 
the page.  Refer to the example abstract. 

  Abstract Body. Use RegText to type the body of the abstract so that the first line 
of each paragraph is indented appropriately.  The body should be double-spaced 
throughout.  Refer to the abstract example for instructions on what to include in the text. 

Key Words. A list of key words appears on the next line below the text 
body.  KEY WORDS is typed flush-left in ALL CAPS, followed by a colon.  The font 
should be 12 pt. and single-spaced, and it should remain flush-left on the page.  Refer to 
the example abstract for more information on key words. 
  

When finished, click on the Insert tab, and click on Page Break to start a new section. 

 
Acknowledgements 
 
The Acknowledgments page is optional and can be deleted if you decide not to use it.  

This is the place in your document where you may either thank all the important people 
in your life who helped you achieve your current success, or other persons you deem as 
important to your work. There is no word limitation.  

**NOTE FOR TEMPLATE USERS:  It is best to wait until you have completely 
finalized your document before deleting this page, unless you are positive that you will 
not use it. 

Non-template users need to format the approval page as follows: 

1. Lower case Roman Numeral (iii), centered, bottom of page. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
3. Font:  12 pt.  Double-spaced throughout.  Use same font style throughout 

document. 
4. Title: Type ACKNOWLEDGMENTS in ALL CAPS, bold, centered on first line 

beneath top margin.  (Use CHPT_Title) 



 15 
 

Body Text. Use RegText to type the body of your text, indenting each paragraph 
appropriately. When finished, click on the Insert tab, and click on Page Break to start a 
new section. 

 

Preface 
 
The Preface is optional and can be deleted if you decide not to use it.  

Generally, it may contain personal details about the nature of the research undertaken, 
how it relates to your background and experiences, and information about the intended 
audience.  Basically, information that is not directly relevant to the research itself.  You 
may also include acknowledgments in this section.  If you do include acknowledgments, 
then delete the Acknowledgments page.  

**NOTE TO TEMPLATE USERS:  It is best to wait until you have completely 
finalized your document before deleting this page, unless you are positive that you will 
not use it. 

Non-template users need to format the approval page as follows: 

1. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
2. Lower case Roman Numeral (iii), centered, bottom of page. 
3. Font:  12 pt.  Double-spaced throughout.  Use same font style throughout 

document. 
4. Title: Type PREFACE in ALL CAPS, bold, centered on first line beneath top 

margin.  (Use CHPT_Title) 
 
 Body Text. Use RegText to type the body of your text, indenting each paragraph 
appropriately. When finished, click on the Insert tab, and click on Page Break to start a 
new section. 

 
Table of Contents 
 
The Table of Contents (TOC) is an organized listing of the chapters and major sections of 
your document.  Readers will immediately be able to see how your manuscript is 
organized and then skip down to sections that are most relevant to them.  A clear, 
concise, and well formatted TOC is the first indicator of a good research paper. 

To save yourself some time in making your Table of Contents, be sure that you use font 
styles.  

Checklist for Table of Contents 

• Appropriately formatted 
• Lists all main sections of the document starting with the Dedication page.  If the 

Dedication page is not used, then starts with the Abstract page. 
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• Lists the titles of each chapter, plus all Heading Level 2's -- these are the main 
sections within each chapter.  Do not list any subsections. 

• All titles and headings match what appears in the text exactly. 
• All page numbers are correct. 

Non-template users need to format the approval page as follows: 

1. Roman Numeral page number, centered, bottom of page. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
3. Font:  12 pt. double-spaced throughout.  Use same font style throughout 

document. 
4. Title:  Type TABLE OF CONTENTS in ALL CAPS, bold, centered on first 

line.  (Use CHPT_HD font style) 
  

Inserting a Table of Contents 

1. Click on REFERENCE tab. 
2. Click on Table of Contents. 
3. Click on Custom Table of Contents. 
4. Make sure that Show Levels is set to 3. 
5. Click on Options.  

o Type a number 1 next to CHPT_title. 
o Remove the numbers next to Heading 1, Heading 2, and Heading 3. 
o Scroll down until you see Heading2 and Heading3.These are the 

headings that you previously created when setting up your document. 
 Type a number 2 next to Heading2. 
 Type a number 3 next to Heading3. 

  

Populating the Table of Contents 
 

The TOC can be automatically generated if you use the pre-formatted font styles 
created in Setting Up Your Document.  As you type your document, remember to use 
each of those font styles as appropriately required.  After adding content: 

1. Click on the Reference tab. 
2. Click on Update Table. 
3. Choose either to: 

A. Update page numbers only. 
 Updates just the page numbers of the existing TOC contents. 

B. Update entire table.  
 Updates all headings and page numbers in the TOC, adding new 

content as needed. 
  

When finished, click on the Insert tab, and click on Page Break to start a new section. 

**NOTE: Below is detailed instructions on how to populate the Table of Contents for the 
traditional and journal-model templates: 
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HEADING 1:  
 
Use style Heading 1 to write your chapter title. You will need to manually write the 
chapter and the chapter number on the line before the chapter title (i.e., CHAPTER I, 
CHAPTER II, CHAPTER V). Center, Bold and ALL CAPS. Select the style ‘Normal’, 
then, in all caps and bold, write the chapter and chapter number (roman numeral) and 
center. On the next line, select style ‘Heading 1.’ Write the chapter title using title-case 
capitalization. Heading 1 is pre-set to be bold and centered. Go to Table of Contents, 
right click and select Update Field or go to References and select Update Table. Select 
update entire table.  
 
**NOTE: In the Table of Contents, the chapter number will automatically populate once 
you’ve written the chapter title. 
 
HEADING 2: 
 
Use style Heading 2 to write main sections of your chapters. These subsections should 
appear in your table of contents. Heading 2 is pre-set to APA 7. Go to Table of Contents, 
right click and select Update Field or go to References and select Update Table. Select 
update entire table.  
 
HEADING 3: 
 
Use style Heading 3 to write subsections. These sections should not appear in your Table 
of Contents but should be used to keep your thesis/dissertation organized. You should 
format these sections according to the style guide/manual you are currently using. In the 
template style Heading 3 is pre-set to APA 7. 
 
 
HEADING 4: 
 
Use style Heading 4 to write subsections. These sections should not appear in your Table 
of Contents but should be used to keep your thesis/dissertation organized. You should 
format these sections according to the style guide/manual you are currently using. In the 
template style Heading 4 is pre-set to APA 7. 

Heading styles are located under Home  
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HEADING 5: 
 
Use style Heading 5 to write subsections. These sections should not appear in your Table 
of Contents but should be used to keep your thesis/dissertation organized. You should 
format these sections according to the style guide/manual you are currently using. In the 
template style Heading 5 is pre-set to APA 7. 
 

List of Tables 
 
A List of Tables is a reference tool that allows your readers to navigate to data quickly 
and easily in your thesis or dissertation.  Construction of the list is like creating a Table of 
Contents. To save yourself some time in making your List of Tables, be sure that you use 
font styles.  

 **NOTE:  You do not have to provide a List of Tables if you have fewer than 5 tables.  

Checklist for List of Tables 

• Appropriately formatted. 
• Lists all tables in the document except those listed in any Appendices. 
• All titles match what appears in the text exactly. 
• All page numbers are correct. 

Non-template users need to format the approval page as follows: 

1. Lower case Roman Number (iii), centered, bottom of page. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
3. Font: 12 pt.  Use same font style throughout document. 
4. Title:  LIST OF TABLES -- ALL CAPS, bold, centered on first line.  (Use 

CHPT_HD font style). 
5. On the next line, change the justification to Justify.  This is the fourth 

justification selection on the right side of the Right Justify button.  It looks like 
four equal-sized lines stacked on top of each other.  This will force the text to 
evenly space itself between the margins. 

 
 

                  
 
  

6. Use RegText to type these two words:  Table Page 
7. Place your cursor in front of the word Page.  Use the Tab key on your keyboard 

to force the word Page to move as far right as possible.  When Page goes onto the 
next line, stop, and use the Backspace key until it is on the same line 
as Table.  Use your spacebar to move Page as far over to the right as you can 
without moving it onto the next line. 
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How to Set the Font Style 
 

1. Click on the down arrow on the far-right side of the visual Style Gallery/Styles 
Pane. 
 

                         
 

     
 

2. Click Create a Style/New Style.  This opens a Create New Style from 
Formatting window. 

3. Change the name to Table title. 
4. Click Modify.  
5. Under Formatting: 

A. Select your chosen font from the drop-down menu (i.e., Times New 
Roman). 

B. Set it to 12 pt. 
C. Left justified. 
D. Single-spaced. 

6. Click on Format in the bottom left-hand corner of the window. 
7. Select Font. 
8. Under Effects, make sure that no options are checked. 
9. Click OK.  Click OK again. 
10. You should now see your new style named Table title in the Style Gallery. 

 
How to Insert a List of Tables 
 

1. Click on the Reference tab. 
2. Click on Insert Table of Figures in the Captions section. 
3. Under General, make sure that Caption label is set to Table. 
4. Also make sure that Include label and number is unchecked. 
5. Click on Options. 
6. Check the Style box and select Table title in the dropdown box. 
7. Click OK. 
8. Click on Modify.  This shows a preview of the font that will be used to create 

your List of Tables. 
9. Click on Modify. 
10. Under Formatting, change the font style so that it matches the font used in the 

rest of your document:  
A. 12 pt. 
B. Left justified 
C. Double-spaced 
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11. Click on the Format button and select Paragraph from the dropdown menu. 
12. Under Indentation, make sure that Left is set to 0.3.  
13. Click Ok, Ok, Ok, and Ok to close all of the windows.  
14. Don’t be surprised if the following appears:  No table of figures entries 

found.  This will be replaced with your table titles as you start inserting them into 
your document. 

15. When finished, click on the Insert tab, and click on Page Break to start a new 
section. 

 
 

List of Figures 
 
The List of Figures allows readers to navigate to those pages containing charts and 
images quickly and easily that are of interest to them. To save yourself some time in 
making your List of Figures, be sure that you use font styles.  

 **NOTE:  You do not have to provide a List of Figures if you have fewer than 5 
figures. 

Checklist for List of Figures 

• Appropriately formatted. 
• Lists all figures in the document except those listed in any Appendices. 
• All titles match what appears in the text exactly. 
• All page numbers are correct. 

Non-template users need to format the approval page as follows: 

1. Lower case Roman Number (iii), centered, bottom of page. 
2. Margins:  Left margin 1.5 inch.  Top, Right, Bottom 1 inch. 
3. Font: 12 pt.  Use same font style throughout document. 
4. Title:  LIST OF FIGURES -- ALL CAPS, bold, centered on first line.  (Use 

CHPT_HD font style). 
5. On the next line, change the justification to Justify.  This is the fourth 

justification selection on the right side of the Right Justify button.  It looks like 
four equal-sized lines stacked on top of each other.  This will force the text to 
evenly space itself between the margins. 

                  
 
 

6. Use RegText to type these two words:  Figure Page 
7. Place your cursor in front of the word Page.  Use the Tab key on your keyboard 

to force the word Page to move as far right as possible.  When Page goes onto the 
next line, stop, and use the Backspace key until it is on the same line 
as Figure.  Use your spacebar to move Page as far over to the right as you can 
without moving it onto the next line. 
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 How to Set the Font Style 
 

1. Click on the down arrow on the far-right side of the visual Style Gallery/Styles 
Pane. 
 

   
 

                                                     
2. Click Create a Style/New Style.  This opens a Create New Style from 

Formatting window. 
3. Change the name to Figure title. 
4. Click Modify.  
5. Under Formatting: 

A. Select your chosen font from the drop-down menu (i.e. Times New 
Roman). 

B. Set it to 12 pt. 
C. Left justified. 
D. Single-spaced. 

6. Click on Format in the bottom left-hand corner of the window. 
7. Select Font. 
8. Under Effects, make sure that no options are checked. 
9. Click OK.  Click OK again. 
10. You should now see your new style named Figure title in the Style Gallery. 

  
How to Insert a List of Figures 
 

1. Click on the Reference tab. 
2. Click on Insert Table of Figures in the Captions section. 
3. Under General, make sure that Caption label is set to Figure. 
4. Also make sure that Include label and number is unchecked. 
5. Click on Modify.  This shows a preview of the font that will be used to create 

your List of Figures. 
6. Click on Modify. 
7. Under Formatting, change the font style so that it matches the font used in the 

rest of your document:  
A. 12 pt. 
B. Left justified 
C. Double-spaced 

8. Click on the Format button and select Paragraph from the dropdown menu. 
9. Under Indentation, make sure that Left is set to 0.3.  
10. Click Ok, Ok, Ok, and Ok to close all of the windows.  
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11. Don’t be surprised if the following appears:  No table of figures entries 
found.  This will be replaced with your figure titles as you start inserting them 
into your document. 

12. When finished, click on the Insert tab, and click on Page Break to start a new 
section. 

 
Body of Thesis or Dissertation 
 
The body of each manuscript contains text describing research performed as part of the 
completion process for a master or doctoral program.  Formatting may vary depending on 
the style guide used, or whether the document is a journal model or a creative thesis; 
however, all manuscripts must adhere to SHSU’s basic format standards: 

• Page Numbers: Arabic numbers (1, 2, 3, 4, etc.), right side, top of page.  Page 
numbers start with 1 on the first page of the first chapter and continue to the end 
of the document. 

• Margins: Left margin 1.5 inch. Top, Right, Bottom 1 inch. 
• Font:12 pt. double-spaced throughout. Use same font style throughout document. 

 
Checklist for Body of Thesis/Dissertation 

• Separated into chapters with chapter titles. 
• Appropriately formatted according to chosen style manual, such as APA, MLA, 

Chicago/Turabian, etc. 
• Headings and subheadings are consistently formatted throughout the 

document.  Do not change heading structure midway through the document. 
• A subheading at the bottom of the page must have at least one line of text beneath 

it.  Otherwise, the subheading may be moved to the next page. 
• Do not use numbering systems to designate sections and subsections.  For 

example: 
o Part 2:  Structure of the Elements 
o Part 2. 1:  List of elements 

• Text is double-spaced throughout.  Do not insert extra blank lines or spacing to 
separate text.  

• You may insert blank lines at the bottom of one page to keep a single Table from 
breaking, or when inserting a Figure. 

Dividing the Content 
 
The first thing you will do when constructing a thesis or dissertation is create a basic 
outline of your content.  This same outline can be used to generate chapter titles and 
headings throughout the document.  

Titles and headings help readers understand how you have structured the subject matter 
and prepares them for what they are about to read.  A logical and consistent progression 
of headings helps with this.  
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Unless stated otherwise in your specific style manual, the following outlines the basic 
structure for titles and headings (Note: Heading styles 2-5 are in APA 7): 

1. Each chapter begins with a chapter designation on the top line of the page:
A. Bold
B. Centered
C. ALL CAPS
D. Followed by a Roman numeral: CHAPTER I, CHAPTER II, CHAPTER

III, etc.
2. The next line is the chapter title:

A. Bold
B. Centered
C. Headline Style Capitalization. (Use Heading1)

3. Heading style 2:
A. Bold
B. Left-justified
C. Headline Style Capitalization. (Use Heading2)

4. Heading style 3:
A. Bold
B. Left-justified
C. Italicized
D. Heading style capitalization (Use Heading3)

5. Heading style 4:
A. Bold
B. Indented for paragraph
C. Heading style capitalization ending with a period.  Regular text starts after

period.  (Use Heading4)
6. Heading style 5:

A. Bold
B. Italicized
C. Indented for paragraph
D. Heading style capitalization ending with a period.  Regular text starts after

period.  (Use Heading5)

You may not need to use all these heading formats but knowing will take some of the 
guesswork out of the creation process. 

**NOTE:  Heading formats must be used in consecutive order.  You cannot skip one 
heading level in preference for another. Also, you cannot have only one subsection within 
a section.  Use at least two, or none.  

Special Instructions for Journal Model 

Doctoral dissertations must contain 3 or more journal articles.  Master's theses 
must contain 2 or more journal articles. If it does not, the the document should be 
formatted to a traditional thesis or dissertation.   



24 

• First chapter contains an Introduction discussing all research presented in the 
document, including:  Literature Review, Study Area, and Literature Cited.

• Each article appears in its own chapter and may have its own List of References.
• Last chapter is a Summary or Conclusion of all research.
• A comprehensive list of all references appears in a Reference/Bibliography 

section.

Special Instruction for a Creative Thesis or Dissertation 

• First chapter contains an Introduction to the document with a review of the
literature or critical essay unifying the presentation and sets the tone of the
work.  The introduction should provide the rationale for the acceptance of a
Creative Thesis.  A bibliography may appear either directly after this section, or at
the end of the document before any Appendices or the Vita.

• Is divided into Chapters.
• Last chapter is a Summary or Conclusion of all research (if applicable).
• A comprehensive listing of all references appears in a Works Cited/Bibliography

section. If no sources are referenced in the Creative section, then a list of
references at the end of the Introduction section is sufficient.

Bibliography, References or Works Cited 

The Bibliography or References appears after the body of the document.  It is a complete 
listing of all cited resources used to create your document.  Even though Journal Model 
authors may have individual Reference sections for each article, this complete Reference 
list of all citations must appear at the end of the entire manuscript. 

Reference lists are formatted according to the instructions provided by the most recent 
edition of your chosen style manual.  In some cases, style manuals do not contain up-to-
date instructions on documentation of electronic publications (i.e., E-mail, software, 
electronic journals, etc.), government documents, or legal documents.  When the 
department’s style manual fails to provide sufficient instructions regarding bibliographic 
documentation, it is suggested that the student consult the Publication Manual of the 
American Psychological Association (APA) or a style manual associated with their 
discipline.  Specialized style manuals for citing legal material and electronic information 
are available in the Newton Gresham Library. 

Checklist for Bibliography, References or Works Cited 

• Includes a complete listing of all resources cited in the document.
• Appropriately formatted according to chosen style guide.  Should be double-

spaced throughout with no extra spacing unless chosen style guide dictates
otherwise.
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Non-template users need to format the approval page as follows: 

1. Page numbers: Arabic numbers (1, 2, 3, 4, etc.), right side, top of page.  
2. Margins:  Left margin 1.5 inch.Top, Right, Bottom 1 inch. 
3. Font: 12 pt. Double-spaced throughout. Use same font style throughout document. 
4. Title: Type REFERENCES or BIBLIOGRAPHY (whichever term is deemed 

appropriate by your style guide) in ALL CAPS, bold, centered on first line 
beneath top margin.  (Use CHPT_Title) 

 
Body Text. Use RegText to type the body of your text, indenting each paragraph 

appropriately. When finished, click on the Insert tab, and click on Page Break to start a 
new section. 

**NOTE: Non-Template users may manually type their citations in the Reference 
section, or use Microsoft Word's Insert Bibliography feature, found under 
the References tab. 

 

Appendix 
 
Appendices serve as a space for materials that help clarify your research, but do not 
belong in the main text.  It is not required to include an Appendix. Include one or more if 
you need to. 

Items that might be included: 

• Letters receiving permission to reproduce or adapt images, instruments for 
research, or other copyrighted materials. (See Copyright section of this website) 

• Copies of IRB’s. 

• Survey questionnaires that you have created. 

• Tables, figures, or instruments that do not belong in the main text. 

Talk to your advisor if you have material that you are not certain about.  They should be 
able to provide guidance about what should be included in an Appendix. Also, consult 
your chosen style guide about and appropriate content and formatting considerations. 

Checklist for Appendix 

• Contains a copy of the IRB (if one was required for research). 
• Contains copies of any copyright permissions if any were needed. 
• Tables and figures are labeled appropriately according to style guide. 
• If there are more than one Appendices, they should be labeled A, B, C... 

Non-template users need to format the approval page as follows: 

1. Page numbers:  Arabic numbers (1, 2, 3, 4, etc.), right side, top of page.   
2. Margins:  Left margin 1.5 inch. Top, Right, Bottom 1 inch. 
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3. Font:  12 pt. Double-spaced throughout. Use same font style throughout 
document. 

4. Title: Type APPENDIX in ALL CAPS, bold, centered on first line beneath top 
margin.  (Use CHPT_Title) 

 
Body Text. Use RegText to type the body of your text, indenting each paragraph 

appropriately. When finished, click on the Insert tab, and click on Page Break to start a 
new section. 

**NOTE: If you have more than one Appendix, label them like the main sections and 
alphabetically.  For instance, APPENDIX A, APPENDIX B, APPENDIX C, etc. In the 
table of contents, label each appendix exactly as shown above as a main section (i.e., 
Acknowledgements, Vita, References, Table of Contents, etc.). Do not add titles to 
appendices.  

 

Vita 
 
A vita is the equivalent of a resume and is used to list your educational and professional 
qualifications.  There are two items of note that should NOT be included in a thesis or 
dissertation vita: 

• Personal contact information 
• Professional references 

These documents are posted on the web and the university cannot control who can view 
them, so it is highly discouraged to provide personal contact information for your 
personal safety.  Also, personal references will change as you progress in your career, 
and so it does not make sense to provide them in this document.  These types of 
information are fine for resumes sent out while job hunting, but not in a bound 
manuscript.  

Your vita may follow one of two formats: 

• Narrative 
• Traditional CV (resume) style 

The narrative contains personal, academic, and professional information about the author 
written in biographical form.  It is similar to the biographical narratives found in books 
by your favorite authors.  

The traditional CV (resume) style is the most common format used.  It is a methodical 
listing of your professional and educational experiences, including any research projects 
and publications you've contributed to.  There is no required format for this 
style.  Instead, you may arrange the contents in the manner that best suits your academic 
field if the general format for theses and dissertations is followed. 
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Consult with your thesis director about which of the two forms should be used in your 
manuscript. 

Checklist for Vita 

• Does not contain any personal contact info such as home address, phone number, 
or email address.  This is for your personal safety since these documents are 
accessible by anyone. 

• Is neatly formatted according to the style used within your field.  Alternatively, 
you can use the narrative format. 

Non-template users need to format the approval page as follows: 

1. Page numbers: Arabic numbers (1, 2, 3, 4, etc.), right side, top of page.  
2. Margins:  Left margin 1.5 inch.Top, Right, Bottom 1 inch. 
3. Font: Use same font style throughout document. 
4. Title: Type VITA in ALL CAPS, bold, centered on first line beneath top 

margin.  (Use CHPT_Title) 
  

Body Text. Use RegText to type the body of your text. 

 

 

 

 

 
 

 

 
 
 

 
 
 



 28 
 

 

CHAPTER III 
 

JOURNAL MODEL 
THESIS/DISSERTATION 
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Journal Model Manuscript 

Departments may elect to use a specific journal’s format for the body of the thesis or 
dissertation; the journal should be a respected scholarly journal well known in the major 
field.  The decision to follow the journal model is made by the student’s department and 
advisor, not the student. 

**NOTE: Doctoral dissertations must contain 3 or more journal articles.  Master's 
theses must contain 2 or more journal articles. If requirements are not met, students 
must restructure their document to SHSU's traditional thesis or dissertation formatting.

Following the journal model means that while each manuscript will follow the same 
structure for front and end matter, the body of the document will be structured according 
to the journal’s standards (with a few exceptions). 

Continuity is provided by a common abstract, introduction, detailed review of the 
literature, and conclusion that ties together the major results and reference 
sections.  Unavoidably, this will duplicate some of the introductory and concluding 
material in each article. 

The following elements are required for acceptance of a Journal Model 
thesis/dissertation: 

• Title Page
• Approval Page
• Dedication (optional)
• Abstract
• Acknowledgments (optional)
• Preface (optional)
• Table of Contents
• List of Tables (if applicable)
• List of Figures (if applicable)
• Body of Document. The body of the document should consist of the following

elements:
o Introduction: Introduction of all research presented in the thesis or

dissertation (including literature review)
o Journal Articles: Each article should be its own chapter and consist of the

following four elements:
 Chapter designation page
 Abstract
 Body of research
 References

o Conclusion: Summary of all research.
• References/Bibliography
• Appendix
• Vita
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Checklist for Body of Thesis 

• Separated into chapters with chapter titles.
• Appropriately formatted according to chosen style manual, such as APA, MLA,

Chicago/Turabian, etc.
• Headings and subheadings are consistently formatted throughout the

document.  Do not change heading structure midway through the document.
• A subheading at the bottom of the page must have at least one line of text beneath

it.  Otherwise, the subheading may be moved to the next page.
• Do not use numbering systems to designate sections and subsections.  For

example:
o Part 2:  Structure of the Elements
o Part 2. 1:  List of elements

• Text is double-spaced throughout.  Do not insert extra blank lines or spacing to
separate text.

• You may insert blank lines at the bottom of one page to keep a single Table from
breaking, or when inserting a Figure.

Special Instructions for Journal Model: 

• Doctoral dissertations must contain 3 or more journal articles. Master's 
theses must contain 2 or more journal articles. If it does not, then the 
document should be formatted as a regular thesis or dissertation.

• First chapter contains an Introduction discussing all research presented in the 
document, including:  Literature Review, Study Area, and Literature Cited.

• Each article appears in its own chapter and may have its own List of References.
• Last chapter is a Summary or Conclusion of all research.
• A comprehensive listing of all references appears in a References/Bibliography 

section.

Journal Model New Chapter Designation 

Each journal article will exist in its own chapter within the thesis or dissertation and will 
be designated as such by providing a chapter heading indicating the chapter number, title 
of the article, and information about which journal the article is modeled after.   

Instructions for creating a Journal Model Designation Page for an article: 

• At the bottom of the cover page for the article/chapter
Beneath a solid line 10 to 15 spaces long

• In a complete sentence with a period at the end
• Suggested wording: This thesis (or dissertation) follows the style and

format of <journal name>.
• Type for journal (Italics, underline or regular) is the same used for journal

titles in reference section; journal name should be spelled out completely
• Single spaced if more than one line
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An example of the Journal Model Designation Page can be seen below. 

Journal Model Designation Page 

Also see below an example of a Journal Model Table of Contents.  The table of contents 
illustrates the breakdown of sections within the document, including the Introduction, 
Journal Articles, and Summary/Conclusions. 

Journal Model Table of Contents  
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CHAPTER IV 

CREATIVE 
THESIS/DISSERTATION
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Creative Manuscript 
 

All theses and dissertations, including those in creative writing and music, are expected 
to conform to the basic university guidelines for margins, paper, and copy quality.  The 
thesis/dissertation should contain an abstract, an introduction, and a review of the 
literature or critical essay that unifies the presentation and sets the tone for the creative 
work.  The introduction should provide the rationale for the acceptance of a creative 
thesis/dissertation. The Graduate School has provided preformatted templates to assist 
with formatting a creative thesis/dissertation; the templates can be found in Chapter II.  

The following elements are required for acceptance of a Creative Thesis: 

• Title Page 
• Approval Page 
• Dedication (optional) 
• Abstract 
• Acknowledgments (optional) 
• Preface (optional) 
• Table of Contents  
• Body of Document: The body of the document should consist of the following 

elements: 
o Introduction: Review of Literature or Critical Introduction 
o Creative section 

• Bibliography/Works Cited 
• Vita 

  

Checklist for Body of Thesis 

• Separated into chapters with chapter titles or main sections (Introduction, Creative 
section/title).  

• Appropriately formatted according to chosen style manual, such as APA, MLA, 
Chicago/Turabian, etc. 

• Headings and subheadings are consistently formatted throughout the 
document.  Do not change heading structure midway through the document. 

• A subheading at the bottom of the page must have at least one line of text beneath 
it.  Otherwise, the subheading may be moved to the next page. 

• Do not use numbering systems to designate sections and subsections.  For 
example: 

o Part 2:  Structure of the Elements 
o Part 2. 1:  List of elements 

• Text is double-spaced throughout.   
• You may insert blank lines at the bottom of one page to keep a single Table from 

breaking, or when inserting a Figure. 
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Special Instructions for Creative: 

• First chapter contains an Introduction to the document with a review of the 
literature or critical essay unifying the presentation and sets the tone of the 
work.  The introduction should provide the rationale for the acceptance of a 
Creative Thesis.  A list of references may appear either directly after this section, 
or at the end of the document before any Appendices or the Vita. 

• Is divided into Chapters.  
• Last chapter is a Summary or Conclusion of all research. 
• A comprehensive listing of all references appears in a Reference/Bibliography 

section.  If no sources are referenced in the Creative section, then a list of 
references at the end of the Introduction section is sufficient. 
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CHAPTER V 
 

INSERTING TABLES 
AND FIGURES 
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Color Images and Copyright 
 
Color Images 

A note on color images:  Color images do not translate well when we make microfilm 
copies of theses and dissertations.  Because of this, we recommend that students change 
their images to B/W or grayscale.  If color is integral to the explanation of your research, 
then you may choose to proceed as is.  

However, when your document is sent to the Press, you will have to provide them with 
detailed instructions about which pages contain color images.  This way, they can print 
only those pages in color, which costs more, and then print the rest of the manuscript in 
B/W.  

Copyright 

Since a thesis is legally classified as a publication, care must be taken not to violate 
copyright laws.  If the thesis contains any material (e.g. figures, tables, test instruments, 
text, or photographs) taken from copyrighted sources, the student must determine if a 
letter of permission from the copyright holder is needed.  This is true even if the student 
or thesis adviser is an author of the material; in such cases, a letter from the publisher 
may still be needed.  

See Copyright section for more information. 

 

Tables 
 

• Tables must appear in the text as near as possible to the discussion relating to 
them.  Under no circumstances will a table precede the first discussion of its 
content.  (Exception:  tables in Appendixes) 

• DO NOT insert a table in the middle of a sentence.  This interrupts the flow of 
thought and is distracting for your readers. 

• Tables must be numbered consecutively using Arabic numbers throughout the 
thesis, as should figures, examples, and illustrations.  Each table in a 
thesis/dissertation must have a caption that tells concisely what it contains.  The 
caption must be placed above a table. 

o Journal Model:  If tables are placed in a separate section, they should 
include a chapter designation as well as a table number (Table 1.1, 1.2, 
1.3; 2.1, 2.2, 2.3) both in the text and in the caption. 

• Computer-generated tables are acceptable, provided they are clear and legible and 
meet margin requirements.  

 
Checklist for Tables 

• Table number and title appears above each table. 
• Table note (if any) appears below each table.  
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• Tables fit within margins.  To see margins, click on the VIEW tab, then click on 
Gridlines. 

• Tables are cleanly formatted, with the least number of horizontal and vertical 
lines to separate main elements. 

• If a table spans multiple pages, the word (continued) appears on the last line of the 
table before the break – this goes for each page where a break occurs. 

• If a table spans multiple pages, the table’s headings repeat at the top of each new 
page.   

• Each table is referenced in the text leading up to it.  Do not place a table in the 
middle of a sentence.  Complete the sentence, then insert the table. 

 
Figures 
 

• Figures must appear in the text as near as possible to the discussion relating to 
them.  Under no circumstances will a figure precede the first discussion of its 
content.  (Exception:  figures in Appendixes) 

• DO NOT insert a figure in the middle of a sentence.  This interrupts the flow of 
thought and is distracting for your readers. 

• Figures must be numbered consecutively using Arabic numbers throughout the 
thesis, as should tables, examples, and illustrations.  Each figure in a 
thesis/dissertation must have a caption that tells concisely what it contains.  The 
caption must be placed below a figure unless the designated style guide/manual 
has an established format to follow. 

o Journal Model:  If figures are placed in a separate section, they should 
include a chapter designation as well as a figure number (Figure 1.1, 1.2, 
1.3; 2.1, 2.2, 2.3) both in the text and in the caption. 

• Computer-generated figures are acceptable, provided they are clear and legible 
and meet margin requirements.  Bar graphs must use shading or hash 
marks: do not use colors to differentiate among data divisions.  Colors do not 
reproduce well in black and white or when microfilmed.  Line graphs should have 
clear distinct lines with symbols that are easily differentiated. 

Checklist for Figures 

• Figure number, title, and note (if needed) appear below each figure.  Do not 
provide additional titles above figures. 

• Template users:  figure note does not appear in the List of Figures. 
• Figures fit within margins.  To see margins, click on the VIEW tab, then click on 

Gridlines 
• Each figure is referenced in the text leading up to it.  Do not place a figure in the 

middle of a sentence.  Complete the sentence, then insert the figure. 
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CHAPTER VI 

 
COPYRIGHT 
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SHSU has provided a  copyright request letter template to assist students in simplifying 
the copyright and fair use process.  
 
Resources 
 
SHSU has numerous resources to further understand copyright and fair use listed below: 
 

1. Newton Gresham Library’s Copyright and Fair Use webpage.  
2. United States Copyright Office. (Copyright Basics and Copyright FAQ) 
3. Copyright and Your Dissertation or Thesis by Dr. Kenneth D. Crews. 
4. Copyright Clearance Center – Copyright Basics. 
5. World Intellectual Property Organization (WIPO) – FAQs about Copyright and 

What is copyright. 
6. Berne Convention for the Protection of Literacy and Artistic Works. 
7. Creative Commons Licenses. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.shsu.edu/dept/graduate-studies/forms/Copyright%20Request%20Letter%20Template.pdf
https://shsulibraryguides.org/copyright
https://www.copyright.gov/
http://www.copyright.gov/circs/circ01.pdf
http://www.copyright.gov/help/faq/faq-protect.html
http://www.copyright.com/learn/media-download/copyright-basics/
https://www.wipo.int/copyright/en/faq_copyright.html
https://www.wipo.int/copyright/en/
https://wipolex.wipo.int/en/text/283698
https://creativecommons.org/licenses/
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CHAPTER VII 
 

THESIS/DISSERTATION 
DIGITAL 

ACCESSIBILITY 
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To increase the visibility of graduate students’ research, The Graduate School has asked 
that students aim to make their thesis/dissertation documents more accessible to people 
with disabilities. By following the checklist below, electronic theses and dissertations 
will be accessible to people who are blind, have low vision, and those who have cognitive 
and/or mobility impairments. The accessibility checklist, in conjunction with using one of 
the Word templates provided, will establish a basic standard that will ideally lead to 
SHSU being a more inclusive research institution. 
 
Accessibility Checklist for Word Documents 
 

1. Heading Styles and Bookmarks 
 
Using heading styles provide organization and structure to your document. The 
Graduate School offers several Word templates with pre-formatted heading styles 
to assist students with organizing their thesis/dissertation. You may need to 
change the font style and position of heading styles/levels depending on what 
style guide you are using. Ensure that your heading styles are consistent 
throughout your document as this is the basis for creating bookmarks within your 
document once it is converted into the final approved PDF version of your 
thesis/dissertation by the Thesis/Dissertation Specialist. For template users, 
instructions on heading levels and how to input headings into the Table of 
Contents can be found in the Table of Contents section in Chapter II.  

 
2. Alt (Alternative) Text Images  

 
Adding alt text to images, tables, figures, pictures, etc., provides a description of 
the images for people who are blind or have low vision. To add alt text, right click 
the picture/image. Select “Edit Alt-Text” and add a description of the image 
(This should be done with all images in your document). If there is descriptive 
text in the image, include that text in the description as well; screen readers 
cannot read text within an image.  

 
3. Edit Document Properties 

 
Adding information to the document properties of your thesis/dissertation helps 
identify your word document and add additional metadata. In Word, select “File” 
then “Properties.” Add the title of your thesis/dissertation in the title field and 
your name in the author field. 
 

4. Color Contrast, Symbols and Bullet Points 
 
Avoid using color fonts or color combinations that will make it difficult for 
people who are color blind or color vision deficient (CVD) to read. For example, 
a sign with a red background and black text cannot be seen by some color-blind 
people (red background with white text is a better option). Avoid using the 
following color combinations in text and images.  
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• Green and Red 
• Blue and Yellow 
• Green and Gray 
• Blue and Gray 
• Green and Brown 
• Green and Black 
• Blue and Purple 

 
Some symbols and bullet points can be difficult to read; an example being the 
asterisk (*). Students are advised to increase the font size slightly on symbols and 
bullets if they appear to be too small for people with low vision to distinguish.  

 
**NOTE: New versions of Word offer an “Accessibility Checker” feature to easily 
check for accessibility issues in your document. In Word, select “Review” then “Check 
Accessibility.” The accessibility checker will appear and list any issues found in your 
document. Please address as many of these issues as possible.  
  
When the final approved PDF version of your thesis/dissertation is sent to you to submit 
through Vireo, the following information will be checked and edited in the PDF 
document properties by the Thesis/Dissertation Specialist: 
 

1. Title and Author Name  
2. Initial View (Show Document Title) 
3. Language (English) 
4. Keywords (Optional) 

 
For more information on accessibility for Microsoft Office suite and Adobe Acrobat 
PDF, follow the links provided:  
 
https://support.microsoft.com/en-us/office/accessibility-video-training-71572a1d-5656-
4e01-8fce-53e35c3caaf4 
 
https://www.adobe.com/accessibility/pdf/pdf-accessibility-overview.html  
 
 
 

 
 
 

https://support.microsoft.com/en-us/office/accessibility-video-training-71572a1d-5656-4e01-8fce-53e35c3caaf4
https://support.microsoft.com/en-us/office/accessibility-video-training-71572a1d-5656-4e01-8fce-53e35c3caaf4
https://www.adobe.com/accessibility/pdf/pdf-accessibility-overview.html


44 

CHAPTER VIII 

VIREO AND EMBARGO 
SUBMISSIONS



The Graduate and Professional School
Sam Houston State University

A Member of the Texas State University System 

Vireo and ProQuest Publication Policy 

Sam Houston State University (SHSU) publishes theses and dissertations electronically through 

Vireo and ProQuest.  

Once a thesis or dissertation is approved and submitted through Vireo, it cannot be edited or 

changed unless there is personal information about the graduate candidate or any study 

participants (i.e., phone numbers, addresses, etc.).  

Graduate candidates must contact the Thesis/Dissertation Specialist or Digital Librarian (Newton 

Gresham Library) to request a change to their published work including the reason for the 

requested changes. 

Name Change on Publication 

SHSU is required to use students’ legal names for all SHSU official documents (i.e., diplomas, 

transcripts, etc.); however, the Registrar’s Office offers a Name Change Request Form for 

students. This form can be used to update a student’s name if (1) they have legally had their 

name changed or (2) they want to use a preferred name.  

If a graduate candidate has legally changed their name, they can submit a request to have their 

name updated on SHSU official documents.  

If the candidate has not legally changed their name, they can submit a request for a preferred 

name change. The preferred name change will only update the candidate’s name on unofficial 

documentation (i.e., class rosters, email addresses, etc.).  

Regarding publishing theses and dissertations in Vireo and ProQuest, The Graduate and 
Professional School has adopted the “Preferred Name Change” policy for transgender and 
genderqueer graduate candidates. Candidates can use their new name on the final draft of their 

thesis or dissertation and on their Vireo submission once the draft has been approved. To ensure 

The Graduate and Professional School is complying with SHSU requirements/policies, 
transgender and genderqueer graduate candidates are asked to include their deadname in 

parenthesis on both their final draft and Vireo submission. 

The candidate should notify the Thesis/Dissertation Specialist about the request to use their new 

name.  

Email: TheGraduateSchool@shsu.edu 

Phone: (936) 294-2408 

Main Campus: Templeton Building 
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https://shsu-etd.tdl.org/
https://about.proquest.com/
https://www.shsu.edu/dept/registrar/forms-and-documents/Name_Change.html
mailto:TheGraduateSchool@shsu.edu
https://shsu-etd.tdl.org/
https://about.proquest.com/
https://www.shsu.edu/dept/registrar/forms-and-documents/Name_Change.html
mailto:TheGraduateSchool@shsu.edu


Embargo Policy 

In certain cases, SHSU recognizes the sensitivity of information in theses and dissertations and 

allows for an embargo to be placed on them to permit candidates time to further their research 

interests. An embargo allows a thesis or dissertation to be withheld from being published 

digitally for a limited time in SHSU’s Institutional Repository and ProQuest. This provides 

candidates time to seek publication as a monograph, in academic journals, or to acquire a patent. 

If a candidate is unsure if an embargo is needed, they should consult their committee chair or 

advisors.  

Candidates must submit an Embargo Request Form (temporary and permanent) in order to be 

approved for an embargo.  

Candidates are not required to submit an Embargo Request Form unless needed. 

Embargo Options  

The criteria for embargo requests are based on necessity. One-year and two-year embargos are 

the most common embargo as they delay thesis/dissertation publication in SHSU’s repository, so 

the graduate candidate has time to submit portions of their research as articles in academic 

journals. Those seeking patents on research also qualify for this embargo. Permanent embargos 

are usually reserved for grant-funded research and for candidates who intend on publishing their 

thesis/dissertation in its entirety as a book or novel; this is usually used by those whose research 

is considered a creative work. 

• One-Year and Two-Year Embargo – This embargo type delays the electronic publishing of

a thesis or dissertation between one and two years. Candidates who wish to submit and

publish parts of their thesis or dissertation in academic journals, monograph, or apply for

patents would benefit from a One-year or Two-year embargo.

• Five-Year Embargo – This embargo is special request only. Candidates must have

justification above what’s needed for the One- and Two-year embargo. This embargo

request will be considered on an individual basis and reviewed and approved by the Dean of

The Graduate and Professional School.

• ProQuest Embargo – This embargo must be completed in conjunction with the one-, two,

and five-year embargo to ensure the thesis or dissertation is not published on ProQuest

before the temporary embargo ends.

• Permanent Embargo – A thesis or dissertation with a permanent embargo is never published

electronically by the University. This embargo is for those who plan to publish their thesis

or dissertation in its entirety, such as a book or novel. Candidates, with permission from

their committee chair, must submit their request for a permanent embargo to the Dean of

The Graduate and Professional School. A decision is communicated to the Thesis/

Dissertation Specialist from the Dean of The Graduate and Professional School and then to

the candidate. A physical copy is kept in Newton Gresham Library’s closed stacks. A digital

copy is kept for preservation purposes, but never made available to the public. Students
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and faculty should carefully consider this decision because, apart from extenuating 

circumstances, a permanent embargo cannot be reversed.  

The Graduate and Professional School’s criteria for embargo requests are not hard-set; meaning,

candidates can have reasons for an embargo outside of what is stated above that may be 

approved.  

The University has asked for nonexclusive distribution rights to your document. In other words, 

even if a candidate’s document is published through the SHSU Institutional Repository, they 

still have all rights to it, including publication. To understand more about these rights, see a copy 

of the license.  

Temporary Embargo Extension 

If more time is needed to submit parts of a thesis or dissertation to an academic journal or are 

still in the process of obtaining a patent, the graduate candidate can extend a temporary 

embargo. 

Candidates are required to contact The Graduate and Professional School or the Newton

Gresham Library to request the extension before the temporary embargo ends.  

Candidates cannot request to replace a temporary embargo with a permanent embargo. 

[Updated: January 11, 2023]
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https://shsulibraryguides.org/ld.php?content_id=54356364
https://shsulibraryguides.org/ld.php?content_id=54356364
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Vireo Electronic Submission Instructions 

Students will submit their documents to Vireo only after receiving approval to do so from 
the Thesis/Dissertation Specialist.  Here is a brief breakdown of the format review and 
publication process:

1. Submit 1st draft for review.
2. Defend Thesis/Dissertation to committee.
3. Submit Electronic Route Sheet after successful defense of thesis/dissertation
4. Submit Final draft for review of complete document with ALL Committee

revisions
5. Receive approval to submit thesis/dissertation to Vireo by thesis/dissertation

specialist
6. Submit thesis/dissertation to Vireo. Click on the following link to access the

Vireo system:  https://shsu-etd.tdl.org/

NOTE: Newton Grisham Library has produced detailed student and faculty instruction 
manuals on how to submit through Vireo. 

Permanent Embargo Submission Instructions 

If a graduate candidate and their committee chair feel that the candidate’s work should 
not be publicly accessible, you can request a permanent embargo. It is the goal of the 
university to publicly promote the academic research presented by its students, so 
permanent embargoes should be considered only if there is a real need. Note: Apart from 
extenuating circumstances, a permanent embargo cannot be reversed. Candidates must 
submit an Embargo Request Form (temporary and permanent) in order to be approved for 
an embargo.  

The University is required to keep a copy of all theses and dissertations for preservation 
and University community use. Candidates retain the copyright to their document and 
may submit the work to publishers without needing permission from the University. 
Below are instructions on how to obtain a permanent embargo: 

https://shsulibraryguides.org/ld.php?content_id=54356364
https://shsu-etd.tdl.org/
https://www.shsu.edu/dept/graduate-studies/forms/VIREO%20Student%20Instructions.pdf
https://www.shsu.edu/dept/graduate-studies/forms/VIREO%20Advisor%20Instructions.pdf
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1. Candidates must fill out an Embargo Request Form and email to
thegraduateschool@shsu.edu. The form must be completed by the deadline stated
in the Academic Calendar (this is usually the same day that Public Defense must
be completed). Students must meet certain criteria to be approved for an Embargo.

2. If the candidate is approved for the embargo, the Thesis/Dissertation Specialist
will send a notification via email to the candidate as well as to the Digital
Resources Librarian.

3. Once the public defense and second review is completed, the Thesis/Dissertation
specialist will send the final approved PDF copy of the thesis/dissertation to the
candidate.

4. Submit the approved PDF document to the Print Services for printing. The
candidate must pay to have their thesis/dissertation printed (you can pay in person
or over the phone). Inform the UP that your document is a thesis/dissertation,
request it be unbounded and on cotton paper, then request the document be sent to
the Newton Gresham Library’s Digital Resources Librarian.

5. After the Newton Gresham Library receives the printed copy, it will be bound and
placed in the catalog and held in the library’s closed stacks where students and
faculty can request to see it. Once your document is received by the library, they
will notify the Graduate School who will then approve your Route Sheet.

6. A digital copy will also be made and kept in the library’s dark archive for
preservation purposes.

**It is important to make sure that your document is received by the library on time as 
your Route Sheet will not be approved until NGL notifies the Graduate School of its 
delivery.  

mailto:thegraduateschool@shsu.edu
https://www.shsu.edu/dept/marketing/university-print-services
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CHAPTER IX 

ORDERDING PHYSICAL 
COPIES OF 

THESIS/DISSERTATION
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The Newton Gresham Library is no longer involved in the printing and binding of theses 
and dissertations.  All theses and dissertations are published electronically in Vireo 
(Institutional Repository). Students should contact their departments and committee 
members to find out if copies are required. 

Students may contact the company of their choice to have copies printed and bound.  The 
following binding companies are not endorsed by the Newton Gresham Library or SHSU 
but are provided as a convenience to you. 

Thesis on Demand 
http://thesisondemand.com 
1-800-334-3628
1010 North Sycamore Street
North Manchester, IN 46962

PHD Book Binding 
http://www.phdbookbinding.com 
8708 S. Congress Ave
Suite A-180
Austin, TX 78745
main: (512) 478-0871
backup: (512) 596-7791 

GradWorks Online 
http://gradworksonline.com/ 
(801) 422-1469
Email: printandmail-support@byu.edu
Brigham Young University
701 E. University Parkway
Provo, UT 84602

Houchen Bindery Ltd. 
http://houchenbindery.com/ 
1-800-869-0420
University Bindery-Division
7917 Watson Rd.
St. Louis, MO 63119

Book1One 
http://www.book1one.com/Services/bookcategories/thesesdissertations 
(585) 458-2101
655 Driving Park Avenue
Rochester, NY 14613

http://thesisondemand.com/
http://www.phdbookbinding.com/
http://gradworksonline.com/
mailto:printandmail-support@byu.edu
http://houchenbindery.com/on-demand-printing/
http://www.book1one.com/Services/bookcategories/thesesdissertations
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Bella Becho Book & Print Bindery 
http://www.bellabecho.com/bookbinding/thesis-binding/ 
(713) 880-8294
404 Arlington
Houston, TX 77007

http://www.bellabecho.com/bookbinding/thesis-binding/
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CHAPTER X 

APPENDIX 
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Appendix A: Example of Title Page 

**NOTE: No page number on Title page. 
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TYPE TITLE HERE IN ALL CAPS 

___________ 

A Thesis <OR> Dissertation 

Presented to 

The Faculty of the Department of <Insert Department Name> 

Sam Houston State University 

___________ 

In Partial Fulfillment 

of the Requirements for the Degree of 

Doctor of <insert degree> OR Master of <insert degree> 

___________ 

by 

<Your official name as found in the Registrar’s office> 

December, 2023 
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Appendix B: Example of Approval Page 

**NOTE: No page number on Approval page. 
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TYPE TITLE HERE IN ALL CAPS 

by 

<Your official name as found in the Registrar’s office> 

___________ 

APPROVED: 

Committee Member Name, PhD 
Committee Director <or> Chair

Committee Member Name, PhD 
Committee Co-Director <or> Co-Chair

Committee Member Name, PhD 
Committee Member 

Committee Member Name, PhD 
Committee Member 

Dean of College Name, PhD 
 Dean, C ollege o f <inser t nam e of coll ege> 
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Appendix C: Example of Dedication Page 

**NOTE: Page number should be roman numeral, bottom and centered on Dedication 
page.  
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DEDICATION 

Click here to enter text. This section is optional. If you do not wish to compose a 

dedication, then delete this page using the navigation pane. If you are nor sure whether 

you will compose a dedication or not, then you should refrain from deleting this page 

until your thesis/dissertation is complete.  
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Appendix D: Example of Abstract Page 

**NOTE: Page number should be roman numeral, bottom and centered on Abstract 
page.  
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ABSTRACT 

Student, Isaac M., The title of the thesis goes here: Use sentence style capitalization.  
Master of Arts (<Insert Major Here>), December, 2016, Sam Houston State University, 
Huntsville, Texas. 

This is the format for the bibliographic information required for the abstract.  The 

content of the abstract that follows this citation will vary according to the subject area.  

The abstract should be concise and informative; however, the abstract must be less than 

350 words in length.  Students should consult their thesis director and style manual to 

determine the content of the abstract.  In general, it should state the purpose and describe 

the subjects and the methodology used in the study.  The abstract should also describe the 

findings, conclusions, and implications of the study.   

A list of key words must be included at the bottom of the abstract; however, key 

words and the title information do not count toward the 350-word total.  Key words 

should be specific terms or phrases used in the thesis that would enable a person to 

successfully search out the content of the document if it were in a library database.  If one 

of the key words is a proper noun, follow the normal rules of capitalization.  Likewise, 

italicize or underline foreign words or appropriate scientific nomenclature.  The first 

word of each key term should be capitalized. 

KEY WORDS:  Thesis guidelines, Index word, Sam Houston State University, Graduate 
School, Texas. 
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Appendix E: Example of Acknowledgements Page 

**NOTE: Page number should be roman numeral, bottom and centered on 
Acknowledgements page.  
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ACKNOWLEDGMENTS 

I would like to acknowledge everyone who played a role in my academic 

accomplishments. First of all, my parents, who supported me with love and 

understanding. Without you, I could never have reached this current level of success. 

Secondly, my committee members, each of whom has provided patient advice and 

guidance throughout the research process. Thank you all for your unwavering support 
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Appendix F: Example of Preface Page 

**NOTE: Page number should be roman numeral, bottom and centered on Preface page.  
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PREFACE 

This basis for this research originally stemmed from my passion for developing 

better methods of data storage and preservation. As the world moves further into the 

digital age, generating vast amounts of data and born digital content, there will be a 

greater need to access legacy materials created with outdated technology. How will we 

access this content? It is my passion to not only find out, but to develop tools to break 

down barriers of accessibility for future generations.  

In truth, I could not have achieved my current level of success without a strong 

support group. First of all, my parents, who supported me with love and understanding. 

And secondly, my committee members, each of whom has provided patient advice and 

guidance throughout the research process. Thank you all for your unwavering support. 
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Appendix G: Example of Table of Contents Page 

**NOTE: Page number should be roman numeral, bottom and centered on Table of 
Contents page.  
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TABLE OF CONTENTS 

Page 

DEDICATION ................................................................................................................... iii 

ABSTRACT ....................................................................................................................... iv 

ACKNOWLEDGMENTS ...................................................................................................v 

TABLE OF CONTENTS ................................................................................................... vi 

LIST OF TABLES ........................................................................................................... viii 

LIST OF FIGURES ........................................................................................................... ix 

CHAPTER I:  INTRODUCTION ........................................................................................1 

CHAPTER II:  TITLE.............................. ..........................................................................14 

 First Level Sub-heading .........................................................................................14 

 First Level Sub-heading .........................................................................................14 

 First Level Sub-heading .........................................................................................16 

CHAPTER III:  TITLE.............................. ........................................................................32 

 First Level Sub-heading .........................................................................................32 

 First Level Sub-heading .........................................................................................33 

 First Level Sub-heading .........................................................................................36 

REFERENCES...................................................................................................................57 

APPENDIX A ....................................................................................................................59 

APPENDIX B ....................................................................................................................64 

VITA ..................................................................................................................................67 
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Appendix H: Example of List of Table and List of Figures 
Pages 

**NOTE: Page number should be roman numeral, bottom and centered on List of Tables 
and List of Figures pages.  
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LIST OF TABLES 

Table       Page 

1    This is the Title for the First Table ...............................................................................1 

2    This is the Title for the Second Table ...........................................................................1 

3    This is the Title for the Third Table ..............................................................................2 

4    This is the Title for the Fourth Table ............................................................................2 

5    This is the Title for the Fifth Table ...............................................................................3 
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LIST OF FIGURES 

Figure         Page 

1    This is the Title for the First Figure ..............................................................................1 

2    This is the Title for the Second Figure ..........................................................................1 

3    This is the Title for the Third Figure .............................................................................2 

4    This is the Title for the Fourth Figure............................................................................2 

5    This is the Title for the Fifth Figure...............................................................................3 
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Appendix I: Example of Chapter Title Page 

**NOTE: Page number should be Arabic, top and right on body section. 
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CHAPTER I 

This is the Title for Chapter I 

Starting typing text here.  This is the first paragraph of this chapter and contains 

lots of valuable information about data collected during this research project.  Figure 1 

demonstrates a part of the research process.  The author must reference the figure before 

it appears in the text.  Use the FigureTitle font style found in the Quick Styles gallery on 

the Home tab to type the figure’s title. Use the Normal font style to type the figure 

number. Manually bold and set the figure number to the left.  
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Appendix J: Example of References, Bibliography or Works 
Cited Page 

**NOTE: **NOTE: Page number should be Arabic, top right on 
References/Bibliography page. The example reference page is using APA 7 citation 
format.  
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REFERENCES 

Barlow, D. (2016). Blues narrative form, African American fiction, and the African 

Diaspora. Narrative, 24(2), 134-155. 

Barrera, I., Amezcua-Allieri, M. A., Estupiñan, L., Martínez, T., & Aburto, J. (2016). 

Technical and economical evaluation of bioethanol production from lignocellulosic 

residues in Mexico: Case of sugarcane and blue agave bagasses. Chemical 

Engineering Research & Design: Transactions of The Institution of Chemical 

Engineers Part A, 10791-101. https://doi.org/10.1016/j.cherd.2015.10.015 

Glądalski, M., Bańbura, M., Kaliński, A., Markowski, M., Skwarska, J., Wawrzyniak, J., 

& ... Bańbura, J. (2016). Effects of nest characteristics on reproductive performance 

in Blue Tits Cyanistes caeruleus and Great Tits Parus major. Avian Biology 

Research, 9(1), 37-43. https://doi.org/10.3184/175815516X14447556559088 

Kendi Morikawa, C., & Shinohara, M. (2016). Heterogeneous photodegradation of 

methylene blue with iron and tea or coffee polyphenols in aqueous solutions. Water 

Science & Technology, 73(8), 1872-1881. https://doi.org/10.2166/wst.2016.032 
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Appendix K: Example of Appendix Page 

**NOTE: Page number should be Arabic, top and right on Appendix page. If there are 
multiple appendixes, each appendix should be on its own page and lettered (ex: 
APPENDIX A, APPENDIX B, APPENDIX C). This labeling should be reflected in the 
table of contents.  
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APPENDIX 

Survey to Establish Socioeconomic Status of Participants 

Please mark the appropriate answers to all questions below: 

What is your age range? 

 ___ 20 to 30 years old 

 ___ 31 to 40 years old 

 ___ 41 to 50 years old 

What is your income level? 

 ___ less than $10,000 per year 

 ___ $10,000 to $20,000 per year 

 ___ $20,000 to $30,000 per year 

 ___ $30,000 to $40,000 per year 

 ___ $40,000 to $ 50,000 per year 

 ___ more than $50,000 per year 

What is your gender identification? 

 ___ male 

 ___ female 

 ___ other. Please explain: ____________________________________________ 

What ethnicity do you identify with? 

 ___ Caucasion 

 ___ Black 

 ___ Hispanic 

___ Asian 
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Appendix L: Example of Vita Page 

**NOTE: Page number should be Arabic, top and right on Vita page. Vita should be no 
longer than 5 pages.  
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VITA 

Isaac M. Student 

EDUCATION 

Master of Arts student in < Discipline > at Sam Houston State University, August 
2002 – present. Thesis title: “Thesis title goes here in normal text.” 

Bachelor of Arts (May 2002) in <Discipline>, Anytown State University, Anytown, 
Texas. 

ACADEMIC EMPLOYMENT 

Graduate Teaching Assistant, Department of <Program>, Sam Houston State 
University, August 2002 - present.  

Research Assistant to U. R. Professor, Department of <Program>, Sam Houston 
State University, Spring 2003 - present. Research activities include… 

PUBLICATIONS 

Student, I. M., and U. R. Professor. 2004. The title of the manuscript goes here. 
Name of the Journal 12:345-250. 

Student, I. M. (In review). Title of a second manuscript. Name of the Journal. 

PRESENTATIONS AT PROFESSIONAL MEETINGS 

Student, I. M., and U. R. Professor. The title of the presentation goes here. 27th 
Annual Meetings of the Society of …, Anytown State University, Anytown, Texas, 
24 June 2004. 

ACADEMIC AWARDS 

Outstanding Graduate Student, Department of <Program>, Sam Houston States 
University, April 2004. 

PROFESSIONAL MEMBERSHIP 

American society of… 

Texas Association of…  
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Appendix M: Example of Journal-Model New Chapter 
Designation Page 

**NOTE: Use whichever style is appropriate below based on the status of the 
manuscript. The manuscript must meet the basic style and format conventions of the 
target journal listed.  
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CHAPTER II 

THE TITLE OF THE MANUSCRIPT BELONGS HERE, CENTERED, ALL CAPS 

AND DOUBLE-SPACED1 

______________________ 

This dissertation follows the style and format of <Insert academic journal in italics> 

1 Student, I. M., and U. R. Professor. 2001. The Journal of Whatever. 82:201-223. 
Reprinted with permission of publisher.  

**Add a footnote if the journal article has already been published.  
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Appendix N: Example of Table, Figure, or Image in Landscape 
Orientation 
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Table 1 

Defining Characteristics of National Football League Mascots 

Mascot Name Team Colors 
Based on a Real 

Animal 
Based on a 

Fictitious Animal 
Based on a Real Human or 

Cultural Group 
Weapon(s) 

Billy Buffalo 
Red, white, and 

blue 
American buffalo Horns on head 

Who Dey 
Orange, black, and 

white 
Bengal tiger Claws and teeth 

Toro 
Dark blue, red, and 

white 
Part man, part 

bull 
Horns on head 

Pat Patriot 
Navy blue, silver 

and red 
Patriot soldiers from the 
American Revolution 

Musket 

Steely McBeam Black and gold American steelworkers A steel beam 

T-Rac 
Navy blue, Titans  

blue, red, and silver 
Raccoon

Warpaint 
Red, gold, and 

white 
Paint horse 

(continued) 
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Mascot Name Team Colors 
Based on a Real 

Animal 
Based on a 

Fictitious Animal 
Based on a Real Human or 

Cultural Group 
Weapon(s) 

Gumbo 
Black,gold and 

white 
Dog

Captain Fear 
Red, pewter and 

orange 
Pirates Sword

Sourdough Sam Red and gold 
49er miners from the 

California gold rush period 
Pickax 

Viktor 
Purple, gold and 

white 
Vikings Hammer 

Note.  Notice the word (continued) that appears in the bottom right corner of the table where it splits and bleeds over onto another 
page.  This informs readers that there is more data on the next page of the manuscript. 
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